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Overview 

TempCentre data management software is comprehensive desktop software designed for downloading configuring 

TempSen made data loggers and viewing, analyzing, storing, archiving data collected during cold chain logistics, which 

is also developed for helping users achieve FDA 21 CFR PART 11 compliance.  

TempCentre software is characterized for its user-friendly interface and process oriented function modules, enabling 

quick access to data by flexible searching, analysis in depth with versatile analysis methods, and provide user with 

accurate and intuitive insight into the environmental conditions that your goods has been experienced throughout supply 

chain. Furthermore, database-based storage and retrieval system would offer a simple ways to pinpoint the data you 

need among the large amounts of data. 

Minimum System Requirements 

 Pentium 1 GHz or higher, 512 MB of RAM or higher 

 A hard drive with 1GB available disk space 

 Windows 7 or above 

 A VGA monitor with display resolution of 1024 x 768px or better 

 Administrator account of the computer. 

Getting Started 

TempCentre provides following basic functions for user to manage data and devices. 

 Downloading Device 

Download data from TempSen made data loggers to local machine. 

 Configuring Device 

Allows user to configure all compatible data logging devices with recording parameters. 

 Data Base 

The light rational data base installed in local machine to store all the data records users choose to save. 

 Viewing and Analyzing Data 

 21 CFR 11 compliance module 

Allows to manage users accessing program, add and manage electronic signatures, assign system 

operation rights, and provides time stamped trails for audit. 
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Menu Bar 

 File   To Open, Save, Export, Delete, Import, Print, Email data records. 

 Options   Provides options to configure date/time, graph and report view settings.. 

 Administration   Allows to add, edit user account, change security settings, and assign user rights 

and meanings for electronic signatures. 

 Devices  Calibration management and firmware update 

 Help   To look up Help file, check for Updates and learn about TempCentre software. 

 

NOTE Administration only available after 21 CFR 11 compliance module is enabled. 

Calibration is applicable to specific types only. 

 

Options 

Please click on Options in menu bar to change general options. 

Date & Time 

Select date, time format for system and date, decimal separators. 
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Date Format Time Format Date Separator Decimal Separator 

dd/MM/yyyy HH:mm:ss / . 

MM/dd/yyyy H:m:s - , 

yyyy/MM/dd hh:mm:ss tt .  

dd/MM/yy h:m:s tt   

MM/dd/yy    

yy/MM/dd    

 

Graph 

 

 

 

 Specify color and type for data curve and limit line display in graph view. 

 Change default setting for graph view. 

 Show/hide limit line 

 Show/hide limit line label 

 Show/hide ideal range 

 Show/hide marks 
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Report Settings 

Basic settings for PDF report exported from TempCentre. 

 

 Company Logo 

Upload an image file for the report header, please make sure use JPG, PNG or GIF format file which is 

not larger than 1MB in size. 

 Show tabular data in report 

 Show event list in report 

User Preference 

 Device Configuration 

 Select default Temperature Unit between Celsius and Fahrenheit for data logger configuration. 

 Auto PDF Report, default setting for auto PDF report created by device 

 Default report language 

 Default time zone 

 Default date format 

NOTE  Date format settings only applicable to specific models supporting customizing time zone for 

auto PDF report. 
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Downloading Device 

Click on (Download Device) in tool bar to enter downloading device mode, TempCentre starts to scan 

all USB ports of current machine to search for data logger to be downloaded, so please plug in USB data 

logger right now, download of data starts automatically once device is found. 

 

Device capable of generating PDF report only begins to establish communication with TempCentre after PDF 

report generation completes, and generally you can see “PdF” on device LCD, indicating that device is 

generating PDF report right now, please wait for couple of se 
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Configuring Device 

Click (Configure Device) in tool bar to enter into configuration mode, TempCentre would begin to 

search and connect TempSen USB data logger automatically, and you are allowed to start configuration of 

device after device is connected. 
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Configuration Options 

 Trip Number 

A unique 10 digits alphanumeric number automatically generated for identifying each monitoring task.  

 Trip Description 

A brief note entered by user for describing monitoring task and to be showed on data report.  

 

NOTE Only ASCII characters are allowed for trip description. 

( ) { } \ are illegal characters for trip description. 

 

 Logging Mode 

1. Standard (Start/Stop) 

Logger stops recording until memory is used up. 

2. Loop (Endless) 

Recording continues even memory is full under this mode, new data overrides old data point in 

memory, logger provides monitoring and alarm statistics over entire monitoring course. Data points 

available will be the latest full memory readings. 

 Logging Interval 

Time interval for logger to sample and record one data point. 

 Start Mode 

1. Manual Start 

Device needs to be started by pressing Start/Stop button, and 2 additional options are available under 

this mode, you need to select one between the two. 

 

a) Start Delay, the time device needs to wait before starting recording after manually activated. 

b)  Condition Start, device starts recording when temperature meets the preset temperature condition, 

there are 3 types of temperature start mechanisms available. 

 Over, device would start recording when temperature goes over the temperature value preset. 

 Under, device would start recording when temperature goes the temperature value preset. 

 Between, device would start recording when temperature falls in between the temperature range 

preset. 

 

NOTE Condition Start applicable to specific models. 
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2. Auto Start 

Allows device to start recording on pre-set specific date/time, logger starts recording automatically when 

time is up, no need to press Start/Stop button after configuration. 

 Repeat Start 

Repeat Start is an independent option under Startup, if enabled, you could restart Alpha data logger for 

next round of monitoring with the same recording parameters of previous recording by pressing 

Start/Stop button, no need to program the logger again. 

 

NOTE Repeat Start is only effective after recording is stopped. 

Repeat Start is only available for multi-use Alpha model. 

 

 Disable Stop Button 

This option is used to avoid mistaken Stop Button action, once enabled, device could not be stopped by 

pressing Start/Stop button on device, recording will stop when logging cycle ends up, however, you are 

still allowed to stop recording through TempCentre. 

 

 Alarm Settings 

1. Alarm Mode 

a) No alarm setting 

b) High & Low alarms, 2 alarm ranges determined by 2 alarm limits. 

c) Multiple Alarm ranges, 5 alarm ranges determined by 5 alarm limits. 

 High ranges: A1, A2, A3  

 Ideal range: A4 (No alarm will be triggered when data falls within this range ) 

 Low ranges: A5, A6 

 

2. Alarm Type 

a) Single Event 

Alarm could only be triggered when data over/under alarm limit for a consecutive time not less than 

alarm delay.  

b) Cumulative Events 

Alarm could be triggered once the cumulatively total time data within alarm range is not less than 

alarm delay. 

 PDF Report Settings 

The following settings are applied to PDF report generated by device automatically. 

 

1. PDF Report Title 

This report title would be used for PDF report created automatically by data logger. 
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2. Time Base 

Select Time Zone and enable/disable Day Light Saving time (DST) for PDF report. 

3. Date Format 

 YYYYY-MM-DD 

 MM-DD-YYYY 

 DD-MM-YYYY 

4. Language 

Select language for PDF report. 

NOTE  PDF reports settings only applicable to specific models.  

 Date formats settings only applicable to specific models. 

 It’s only allowed to enter ASCII characters for report title. 

 ( ) { } \ are illegal characters for report title. 

 

 Advanced Settings 

1. Disable Stop Button 

If enabled, device will be stopped manually by pressing Stop button. 

2. AccessKey 

AccessKey is used to protect the configuration attempts to device, if set, AccessKey will be written into 

device, and user will be prompted to enter AccessKey before next time configuring device.  

AccessKey comprises of six numeric characters. 

 

Apply Configuration 

Click Apply button on status bar of workspace to write configuration parameters into device. 

 

 

Configuration Profile 

 Saving Configuration Profile 

Save current configuration parameters as configuration profile for future use by clicking Save Profile on 

status bar of workspace. 

 

 

IMPORTANT 

Please do not remove device from computer before you are prompted of configuration 

success to avoid configuration error. 
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Configuration profile will be saved as .tpscfg format file, and it’s a product model specific file, so it will 

cause configuration error if configuration profile is applied to different model of product. 

 

NOTE  All configuration parameters and options except Trip Number will be save as part of 

configuration profile. 

 Auto start time could not be saved into configuration profile. 

 Loading Configuration Profile 

You could simply load the recently used configuration profile from configuration profile drop list, or load 

new profile by clicking on Open to choose the configuration profile you need. 

 

 

 Restore Configuration to Default 

Click  right to Open button to restore current configuration parameters to default parameters. 

 

  

 

IMPORTANT 

 Configuration profile only can be applied to the product of same model. 

 Configuration profile may not be applied to product with significant change in firmware. 
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Viewing and Analyzing Data 

Summary View 

In summary view you could see all summarized monitoring information and statistics. 
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Graph View 

Readouts are plotted as curve(s) in graph view, you could have intuitive understanding about temperature or 

humidity fluctuations throughout monitoring. 

 

 

 

 

Move mouse over any data curve, a window carrying detailed formation of closest point appears.  

 

 Mini Graph 

Mini graph presents complete data curve(s) throughout monitoring cycle, and you could specify a time 
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range on thumbnail graph by dragging the vertical bars  on both left and right side of thumbnail graph 

to zoom in the data falling within the range selected on main graph, to enable precise partial analysis . 

 

Report View 

Combining summary, graph and tabular view into report view, which also constitutes the layout and 

contents of PDF report exported from TempCentre. 

 

 

NOTE  Report view is only able to display 25 pages of report, please browse the remaining pages 

in exported PDF report. 

 

Extension Window 

Extension window is located at the bottom of workspace, which includes several tabs to present a variety of 

information related to data record and device. 

 Table View 

All data points present in table view 
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Any values violating alarm thresholds display in red, and time stamped marks display in blue.  

 

Real-time Statistics 

Statistics for data within time range specified on mini graph show in table of real-time statistics statistical 

values change as time range changes, statistics include: 

 

 

1. Data Points, number of data points within selected time range. 

2. Length, time length of the selected time range. 

3. Max, maximum value of data within selected time range.  

4. Min, minimum value of data within selected time range.  

5. Avg, average value of data within selected time range.  
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 Violation Events 

Statistics for each alarm limit violation event would be displayed in date order, every individual event 

with duration time longer than preset alarm delay is highlighted in bold red. 

 

 

 Comments 

Enter comments for current data record, you are allowed to input up to 250 characters. 

 

 Signatures 

Review electronic signature history information of current data record.  

  

 

 Info 

Display additional information of data record and device.  
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View Options 

Click View Option in right upper corner of workspace, a menu with options for setting up all views appears. 

 

 

1. Temperature Unit, convert temperature readings between Celsius and Fahrenheit. 

2. Show/hide measurement channel, choose to turn on/off the display of one of the measurement 

channels if there is more than one channel available. 

3. Edit Marks, edit alias of time marks placed during recording for better identification.  

4. Graph View Options 

a) Show Limit Line, check to show alarm limit line 

b) Show Limit Line Label, check to show alarm limit line label 

c) Show Ideal Range 

d) Show Marks 

e) X Axis, change X axis between different coordinate options. 

 Date/Time 

 Elapsed Time 

 Data/Points 

 

NOTE Options in View Option menu will vary under different views. 
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Data Base 

Data base is the where user could search, retrieve, analyze, comment and compare data stored in 

TempCentre data base.  

Please click   on tool bar to enter data base mode. 

Data Record List Pane 

You could search data records in left pane, all data records stored in data base will be presented in pages, 

please navigate to certain page through page selector at the bottom of pane. 

 

Click on  to extend data record list to data record table, more columns would appear. 

 

 

 Select and View Operation 

Single click on a data record in data record list pane to select a data record. 

Double click a data record in data list pane to view a data record. 

“ ” displays in column left to record name indicating this data record is currently presented in current 

views. 
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 Menu Options 

After selection of data record in list pane, right click mouse you will have an operation menu for data 

records. Please find menu options as below. 

 Rename Data  

 View Selected Data 

 Export Selected Data 

 Delete Selected Data 

 Compare Selected Data 

 Add to Data Comparison 

 Remove from Data Comparison 

 Exit from Data Comparison 

 Data Record ID and Name 

 Each Record ID is composed of device serial number and trip number.  

 Data record name is the same with record ID by default, you are allowed to change record name by 

right clicking on data record list pane, select Rename Data to perform renaming, a maximum of 50 

characters are allowed for a record name. Record name is used as data record identification and 

file name of data exported. 

Filters and Searching 

With the assistance of retrieve criteria and searching function, you could quickly locate the data record you 

need. 

 Filter Criterias 

1. Date Range: Define a data range by specifying start and end date. 

2. Status: Filter data on different alarm status, including Alarm, OK, No Alarm Setting. 

3. Latest Time Period Selectors: Quickly specify latest time period to narrow down search scale. 

 Searching 

You are allowed to search for specific data directly record by Record Name, and you could also search 

by Record ID or Trip Description through changing search options, click downward arrow left to search 

input box to expand search option menu. 
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 Restore to Default State 

Please click on  to clear all filters and restore to default state. 
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Data Comparison 

Search for multiple data records and put them together into data comparison. A maximum of up to 50 data 

records could be put into data comparison.  

 

 

How to compare different data records 

1. Multi-select the data records you need to compare in data record list pane. 

2. Right click mouse, select Compare Selected Data 

3. Data comparison begins 

 

You could also add data to or remove data from comparison, right click on mouse in data record list panel, 

select Add Data to Comparison or Remove Data from Comparison. To exit from data comparison, please 

right click mouse in data record list panel, select Exit from Data Comparison  

 

Comparison Views 

 Summary View 

In data comparison, summary view presents summarized information of all data into tabular views. 

 Graph view 

In data comparison, curves representing every data record will be plotted into one graph. If there is more 

than one measurement channel (sensor) in records compared, then sensor 1 will be displayed as default 

view, please switch to “Sensor 2” in View Option menu.  
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 List View 

In data comparison, readings from all data records display in tabular view in extension window. 

Opening and Importing Data Files 

Please open and import external file by clicking File in menu bar, and select Open to open single file, and 

select Import to import multiple files into TempCentre data base. 

 

Compatible File Formats 

1. .tps format file, please note TempCentre 2.0 or above could not open or import ,tps format file created 

by TempCentre 1.3.3 or lower. 

 

Exporting Data Files 

Please move to File>Export or click Export button on title bar of workspace, to export currently viewing data 

record. Or you could select data record(s) in data record list pane of data base, and right click mouse, 

choose Export Selected Data Record to export currently selected data records. 

 

TempCentre provides the following three formats that data record could be exported as: 

 

a) Export to TPS: TPS(.tps) is a self-defined encrypted format developed by TempSen for exchanging 

data in between TempCentre software. 

b) Export to PDF: Data report will be saved as an Adobe© PDF format file. 

c) Export to Excel: Data report will be saved as spreadsheet format (.xlsx). Data records in 

comparison would be exported in batch to one spreadsheet file. 

Handling Data Records 

Trimming Data 

Trimming data is a way to re-define the time range of a data record, to create a new data record based on 

the time range user actually needs, trim for data will not affect the original data record, the trimmed data 

record will be saved to data base (if user selects to do so) as a new data record, with a new trip number (the 

original trip number ended with _X1,2,3...). Mathematic statistics like maximum, minimum, average, MKT 

values will be re-calculated within the new time range. 

 

Please click on Operate button in workspace status bar, see as below 
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Trim a data record in following 4 ways. 

 

Trim by time Trim data with the new start and stop time specified. 

Trim by data points Trim data with the new start and stop points specified. 

Trim by checkpoints Trim data with the new start and check points (start, time marks, stop) selected. 

Trim on mini graph Trim data based on the time range selected on mini graph.  

 

Resetting Alarm Settings 

This functionality allows you to reset alarm settings of existing data record, which is very useful in scenario 

like no alarm setting was set to loggers already deployed in shipment, but QA needs to analyze the data with 

alarm thresholds specified in quality manual after goods arrived. 

 

Data record with alarm settings changed would be saved into data base as a new data record.  
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Data record with alarm settings reset will be saved into database as a new data record. 

21 CFR 11 Compliance Module 

What’s 21 CFR 11 Compliance? 

The Food and Drug Administration (FDA) issued regulations Title 21 Code of Federal Regulations  

Part 11 that provide criteria for acceptance by FDA, under certain circumstances, of electronic records, 

electronic signatures, and handwritten signatures executed to electronic records as equivalent to paper 

records and handwritten signatures executed on paper. These regulations, which apply to all FDA program 

areas, are intended to permit the widest possible use of electronic technology, compatible with FDA’s 

responsibility to promote and protect public health. Part 11 applies to any record governed by an existing 

FDA predicate rule that is created, modified, maintained, archived, retrieved, or transmitted using computers 

and /or saved on durable storage media. 

How to achieve compliance with TempCentre? 

With help of 21 CFR 11 Compliance module, TempCentre would assist regulated companies to meet 

compliance by implements user administration, access control, and electronics signatures and records 

retention. 

Activating 21 CFR 11 Module 

21 CFR 11 compliance module is not a default function ready for use after software installation, you need to 

active this module by going to Help>Enable 21 CFR 11 Module. 
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After 21 CFR 11 compliance module is enabled, program will restart for the changes to take effect. 

  



   

UM-TEMPCENTRE2-141010 REV.D

Electronic Signature 

Electronic signature means a computer data compilation of any symbol or series of symbols executed, 

adopted, or authorized by an individual to be the legally binding equivalent of the individual’s handwritten 

signature. 

 

Once you decide an electronic signature, there will be user authentication as first step, the process of signing 

consists of: 

 

 User authentication 

 Checking permission of adding an electronic signature 

 Selection of a meaning from a pre-assigned meanings list. 

 

Electronic signature generates printed name of signer, date and time of execution, history of all signatures 

related to this electronic record. 

 

Please check out signature history tab in the extension window in workspace. 

 

 

 

NOTE You are allowed to add up to 200 electronic signatures to one data record. 
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User Accounts 

After 21 CFR 11 compliance module first enabled during installation, you will be asked to setup the first 

admin account, user account comprise of following information. 

 

Account Information 

User Name Unique login name, up to 30 alphanumeric characters  

Full Name Full name, up to 50 alphanumeric characters 

Password 6 to 24 ASCII characters 

Role Defines your role in your organization, up to 50 alphanumeric characters 

Type Select between User Account and Administrator Account 

 

Difference between User Account and Administrator Account 

1. Administrator account could create, edit, lock and manage other accounts, including administrator 

accounts. 

2. Administrator account  

 

Please go to Menu bar > Administration > User Account to add, edit, lock or unlock users in system. 
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Security Policies 

To control visit to system, protect important information and prevent hostile access, you could enable and 

change the following security policies. 

1. Lock user after [ ] consecutive failed logon attempts. User account will be locked if he/she login to 

system with incorrect user name or password for certain number of times in a row. Please ask admin 

account to unlock the locked account, max 9 attempt failures.  

2. Force logout if inactive time over [ ] minutes. Specifies user session expiry time, max 999 minutes. 

3. Password expires after [ ] days(s).  Defines password expiry time, max 999 days. 

 

Please leave input box empty or input zero (0) to disable any policy.  

User Rights 

TempCentre offers a series of system rights for controlling users’ access to specific functions, rights available 

are shown below: 

 

 Configure device 

 Sign data (sign electronic signature for data record) 

 Edit data (add comments, marks, change record name, report title) 

 Change options (change system options) 

 Delete data 

 View audit trail 

 

Admin account has all of the above rights by default. 

Meanings 

Allows admin account to add, edit, delete and assign meanings for user who will and has the right to sign 

electronic signature. 
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NOTE You are allowed to add up to 100 meanings in TempCentre program. 
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Audit Trail 

Audit trails record all critical actions, including changes made to system or data records, to enable users, 

reviewers and inspectors to be aware that what, who, when about the changes made. 

 What changes have been made 

 Who made the changes 

 When the changes are made 

 

TempCentre provides two types of audit trails, system audit trail and analysis audit trail。 

 

 

 

 

NOTE Please click on  in pane left to refresh trails. 
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 System Audit Trail 

The system audit trails record all critical system changes, and followings are sample system change 

actions. 

 

Action User Name (Operator) Details  Action Detail Explanation 

Add user Jack Lilly: User, “Lilly Yen” Object user: account type, “full name” 

Edit user Jack Lilly: Position “QM” Object user: position detail 

Edit user Jack Lilly: Full Name “Alex Ariston” Object user: edit detail 

Change Group Jack Lilly: Old “User”, new “Admin” Object user: Old account type, new account type. 

Lock user Martin Jack Object user 

Lock user System Jack User locked by system 

Unlock user Martin Lilly Object user 

Change password Jack Lilly Object user 

Log on Anderson Failed Login result 

Log off Anderson Successful Logout result 

Add meaning Lisa “Released” Meaning name 

Delete meaning Lisa “Tested” Meaning name 

Assign meaning Lisa Macus: Added “Release” Object user: Meaning added 

Assign meaning Lisa Jackson: Removed “Rejected” Object user: Meaning removed 

Edit meaning Macus Old “Release”, new “Released” Old meaning, new meaning 

Change rights Max Lilly: Added “Sign record” Object user: right added 

Change rights Julian Sarah: Removed “Delete Record” Object user: right removed 

Change security 

policies 
Miya 

Password validity: Old “30 days”, new 

“10 days” 
 

Change security 

policies 
Miya 

Force logout inactive time: Old N/A, 

new “30 minutes”  
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Change security 

policies 
Miya 

Failed login attempts restriction: Old 

N/A, new “6” 
 

System Event Max 
21 CFR 11 Compliance Module 

Deployed 
  

 

 Analysis Audit Trail 

The analysis audit trail keeps significant changes to electronic records and devices, followings are the 

actions deemed as changes to data. 

 

Action User Name Details  Action Detail Explanation 

Configure device Jack DE12345678, ITAG3 Pro 
Configured device serial number, device 

model. 

Save record Jack DE12345678_ DE12345678 Record ID of data saved 

Import record Maria DE12345678_ DE12345678 Record ID of data imported 

Edit comment Jack 
DE12345678_ DE12345678: “Thermal 

research_2015_09_logistics” 
Record ID: “Comment after edit” 

Edit record name Ema DE12345678_ DE12345678: “a new data report” Record ID: ”Record name” 

Edit mark Lisa DE12345678_ DE12345678: Mark 1 “Open door” Record ID: Mark number “Mark Name” 

Edit report title Elva 
DE12345678_ DE12345678: “New Vaccine 

Delivery” 
Record ID: “Report Title” 

Sign data Anderson DE12345678_ DE12345678: “Approval” Record ID: “Meaning” 

Trim data Anderson 
DE12345678_ DE12345678：DE12345678_ 

DE12345678_X1 

Record ID: Record ID of data after 

trimmed and saved 

Reset Alarm 

Settings 
Nicole 

DE12345678_ DE12345678：DE12345678_ 

DE12345678_X1 

Record ID: Record ID of data after alarm 

reset and saved 

Delete record Anderson DE12345678_ DE12345678_22 Record ID of data record deleted 

Delete record Anderson All data deleted  

Renew calibration Mike DE12345678 
Serial number of logger with calibration 

renewed 
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 Filter  

Filter allows you to quickly find the audit trails you need, to facilitate accurate review or inspection. 

 

Following filter options are available.  

 

 Item 

 Action 

 User 

 Date/Time 

 Export and Print Audit Trail 

To export or print the current audit trail, please go to menu bar, File>Export or Print to export or print 

audit trail under current filter criteria.  
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Devices 

Calibration 

Calibration validity period management is now available from TempCentre 2, to enable user to properly 

maintain calibration validity throughout device life cycle with periodical reminder, you will be prompted if 

calibration of current connected device will be due within 30 days. 

 

You could go to Menu bar>Devices>Calibration to renew calibration information after receipt of this 

information, or you could turn off calibration notification on currently connected logger if you don’t need it. 

 

 

 

 

NOTE Only part of Alpha logger models support calibration validity management,  
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Downloading TempCentre 

Please download and install the latest version of TempCentre software from www.tempsen.com 

How to download TempCentre software? 

 If it’s your first time to download software from www.tempsen.com, please sign up with the information 

required prior to downloading, then an email containing download link would be sent to the mail address 

you left in couple of minutes. 

 If you want to download the software from again after your successful registration last time, please click 

“I already signed up, download now” button in dialogue box, then software would begin to 

download in couple of minutes. 

Update 

Please go to Help>Check for Updates to start TempCentre updater, then updater would start searching for 

available updates for current version online. If update is available, please download the update and then 

perform update. 

 

TempCentre updater program also checks the availability of new update automatically every TempCentre 

starts running, and you will be prompted to download and perform update when update is available. 

 

Auto update defaults to enabled, and you are allowed disable auto Update by going to Help>About 

TempCentre, click on Disable Auto Update. 

 

NOTE Only could operation system administrator account perform update. 

Installation and Uninstallation 

Installation 

1. Double click on TempCentre_2.0_Setup.exe to start installation 

2. Click on Next in Welcome page 

3. Select “I accept the terms in the License Agreement” to proceed. 

4. Select language versions for program to be installed 

5. Select or specify destination for program and data file (Data Base file) 

6. Click Install 

file:///C:/Users/Issac/Desktop/www.tempsen.com
file:///D:/Cloud/TempSen/设计/文件设计/USER%20MANUAL/www.tempsen.com
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7. Click Finish 

8. Installation completes. 

 

NOTE Please DO NOT place Data File folder under any of the following folders in system disk, otherwise 

TempCentre will prompt Error while program runs. 

 C:\Program Files 

 C:\Program Files(x86) 

 C:\Program Data 

 

Uninstallation 

1. Select Start, go to Control Panel 

2. Navigate to Add or Remove Programs 

3. Select TempCentre in list, click on Uninstall/Change 

4. Uninstallation completes 

  



   

UM-TEMPCENTRE2-141010 REV.D

Data Base Backup 

Backup 

Please backup the database file tempsen.db in data file folder. 

Restore 

Please replace the tempsen.db in data file folder with your backup tempsen.db file.  
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MKT 

MKT (Mean Kinetic Temperature) is a simplified way of expressing the overall effect of temperature 

fluctuations during storage or transit of perishable goods.  

 

Calculation： 

 

𝑇𝑚𝑘𝑡 =
ΔE/R

−ln⁡(
𝑒−

∆𝐸
𝑅𝑇1 + 𝑒−

∆𝐸
𝑅𝑇2 +⋯+ 𝑒−

∆𝐸
𝑅𝑇𝑛

𝑛
)

 

 

ΔE = activation energy (standard value: 83.144 kJ/mol)  

R = 8.314472 J/mol-K (universal gas constant)  

T = temperature in degrees K  

n = the number of sample periods over which data is collected 

 

Note: ln is the natural log and ex is the natural log base. 

 

NOTE Device does not provide MKT value under loop recording mode. 

 

 Why is MKT important in the life of pharmaceuticals and perishable 

goods?  

The pharmaceutical and food industries are two closely regulated markets. The FDA provides regulations that require 

warehouse and shipment temperatures to be closely controlled and monitored. In addition, the FDA requires well-

documented verification of these storage environments and any corrective actions taken if temperatures exceed 

specified storage conditions. 
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